
Create 3D Objects from 2D
Objects

This tutorial outlines the procedures to create 3D solids and surfaces from 2D objects with
solid modeling and editing methods.

Audience: Users new to 3D modeling in AutoCAD

Prerequisites: Working knowledge of 2D drafting

Time to complete: 15 minutes

Objectives
■ Loft 2D objects (profiles) to create 3D objects

■ Sweep 2D objects (profiles) along a path to create 3D objects
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■ Revolve 2D objects (profiles) around an axis to create 3D objects

Tutorial Files
All necessary files for this tutorial are located at
http://www.autodesk.com/autocad-tutorials.

Recommended: Before starting the tutorials

1 Download the create_3DObjects_from_2DObjects.zip from
http://www.autodesk.com/autocad-tutorials/.

2 Unzip create_3DObjects_from_2DObjects to C:\My Documents\Tutorials.

Before Starting This Tutorial
To switch to the 3D Modeling Workspace

1 On the status bar, at the bottom of the drawing area, click the Workspace
Switching button.

2 On the Workspace menu, click 3D Modeling.

The 3D Modeling workspace is displayed. The Workspaces icon in the status
bar indicates that you are now in the 3D Modeling workspace. In this
workspace, you can access the various commands and tools needed for creating
3D drawings.
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Lesson 1: Loft 2D Objects and Shell a 3D Solid
In this lesson, you create 3D objects from 2D objects by lofting. Then you
modify and edit the lofted 3D object by shelling.

You can create a 3D solid or surface between cross sections (2D profiles) of
the object. Lofting creates a solid or surface object that flows through other
objects that define its shape.

The cross sections that you use when lofting must be open to create a surface
or all closed to create a solid. You cannot use a selection set that includes both
open and closed objects.

To create a surface by lofting a 2D open object (arc)

 1 Click  ➤  Open.

2 In the Select File dialog box, browse to C:\ My Documents\Tutorials
and select sheet.dwg.

3 Click Open.

4 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Loft.
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5 Select the two arcs in the drawing and press Enter.

6 At the prompt, enter C for cross section and press Enter.
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7 In the Loft Settings dialog box, under Surface Control At Cross
Sections, select Draft Angles.

8 In the Start Angle and End Angle boxes, make sure that it is 315.

9 Click OK.

You have created a surface object that represents a sheet.
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10 On the ViewCube, located at the upper-right corner of the drawing
window, click Top and Front to navigate around the sheet.

NOTE For more information on ViewCube, see the AutoCAD User's Guide
or refer to the AutoCAD 2009 tutorial: Navigating a model with ViewCube.

11 To close the drawing without saving, click  ➤ Close.

To create a cup by lofting 2D closed objects (circles)

 1 Click  ➤  Open.

2 In the Select File dialog box, browse to C:/My Documents/Tutorials and
select Create_cup.dwg.

3 Click Open.

4 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Loft.
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5 Select the two largest circles as shown in the drawing and press Enter.

6 At the prompt, select Cross sections only.
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7 In the Loft Settings dialog box, under Surface Control At Cross
Sections, select Draft Angles.

8 Then, in the Start Angle and End Angle boxes, enter 90.

9 Click OK.

The Draft Angles option controls the magnitude of the first and last
cross sections of the lofted solid or surface. The draft angle is the
beginning direction of the surface.

10 On the ViewCube, located at the upper-right corner of the drawing
window, click Top, Front, and Right to navigate around the 3D solid
object.
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11 ToClick  ➤ Save to keep your changes.

To edit the cup by shelling to create a hollow

A 3D solid object can be hollowed with the Shell option of the SOLIDEDIT
command. When you shell a 3D solid object, new faces are created by offsetting
existing faces inside or outside from their original positions.

Using Create_cup.dwg from the previous lesson, you will hollow the cup by
shelling the lofted 3D solid object you created.

 1 On the ribbon, click Home tab  ➤  Solid Editing panel  ➤  Solid
Editing drop-down  ➤  Shell.
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2 Select the lofted 3D solid object.

3 Select the top face of the 3D solid object and press Enter.
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4 At the prompt, enter 0.5 as the shell offset distance. Press Enter.

5 At the prompt, select eXit to exit the body editing option.

6 At the prompt, select eXit to exit the solid editing option.
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You have shelled the 3D solid object to create a hollow cup.

7 At the prompt, enter FACETRES and press Enter. This command
controls the smoothness of 3D solids.

8 At the prompt, Enter new value for facetres, enter 10 as the new
value for facetres. Press Enter.

Valid values are from 0.01 to 10.0.

9 On the ViewCube, located at the upper-right corner of the drawing
window, click Top, Front, Right, and Left areas to navigate around
the hollow cup.

Summary: In this lesson, you learned to

■ Loft 2D open and closed objects to create a 3D surface and 3D solid object

■ Hollow a 3D solid object with the Shell solid editing option

Lesson 2: Sweep 2D Objects Along a Path
In this lesson, you create 3D objects by sweeping 2D objects along a path.

You can create a 3D solid or surface by sweeping a 2D object, also known as
a profile, along a 2D or 3D path. You can sweep more than one profile at a
time, but they all must lie on the same plane.
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To create a handle by sweeping a circle along a path

 Using the same drawing file that you used in the previous tutorial,
Create_cup.dwg, you will sweep a circle along a path to create the handle
of the cup.

1 At the Command prompt, enter delobj. Press Enter.

2 At the prompt, enter 1 to retain the defining geometry. Press Enter.

3 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Sweep.

4 Select the circle and press Enter.
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5 Select the arc to specify the sweep path.

You have created a handle for the cup.
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6 Click  ➤  Save.

To create a surface by sweeping

1 Click  ➤  Open.

2 In the Select File dialog box, browse to C:/My Documents/Tutorials and
select mold.dwg.

3 Click Open.

4 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Sweep.
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5 Click the three lines as shown in the illustration and press Enter..

6 Select the arc to specify the sweep path.
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You have created the surface of a mold.

Summary: In this lesson, you learned how to sweep 2D open and closed objects
along a path to create 3D surfaces and solids.

Lesson 3: Revolve 2D Objects Around an Axis
In this lesson, you revolve 2D objects around an axis to create 3D solids and
surfaces.

A 3D solid or surface can be created by revolving a closed or open planar curve
about an axis at a specified angle. Objects that can be revolved are 2D solids,
3D faces, arcs, circles, ellipses, elliptical arcs, lines, 2D polylines, regions, 3D
solids faces, 2D splines, 3D surfaces-planar faces, and traces.
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NOTE While revolving a wide polyline, the width of a polyline is ignored and the
revolution takes place from the center of the polyline. Polylines that have crossing
or self-intersecting segments cannot be revolved.

To create a 3D solid model by revolving

1 Click  ➤  Open.

2 In the Select File dialog box, browse to C:/My Documents/Tutorials and
select Rim.dwg.

3 Click Open.

4 On the status bar, click the Object Snap button to enable object snap
mode.

5 Right-click the Object Snap button and click Endpoint to turn it on. The
Endpoint option should now have a box around its icon which indicates
the object snap is enabled.

6 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Revolve.
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7 Select the object shown in the illustration and press Enter.

8 Select the left endpoint of the red line to specify the axis start point.
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9 Select the right endpoint of the red line to specify the axis end point.

NOTE The red line will be used as the axis of revolution.

10 At the Command prompt, enter 30 as the angle of revolution. Press Enter.
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11 To remove the reference path, on the ribbon, right-click any panel on
the Home tab.

12 On the ribbon, right-click any panel on the Home tab and click
Panels ➤ Layers.

13 Click the Layer drop-down list.

14 Click the Light Bulb icon next to the 00 REFERENCE layer to turn it off.

You have revolved the 2D object around its axis to create a rim.
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To revolve an object around an internal point to create a glass

 1 Click  ➤  Open.

2 In the Select File dialog box, browse to C:/My Documents/Tutorials and
select Glass.dwg.

3 Click Open.

4 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Revolve.
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5 Select the glass section in the drawing and press Enter.

6 Select the top endpoint of the glass step as shown in the illustration.
This selection specifies the axis end point..

7 Select the top endpoint of the glass step as shown in the illustration
to specify the axis end point..
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8 At the prompt, enter 360 as the angle of revolution. Press Enter

You have created a glass.
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9 At the prompt, enter -shademode and press Enter. This gives the
glass a smooth, realistic appearance.

10 At the Command prompt, enter g (for Gouraud) and press Enter.

Gouraud shades the objects and smooths the edges between polygon
faces.
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To create a 3D surface by revolving

1 Click  ➤  Open

2 In the Select File dialog box, browse to C:/My Documents/Tutorials and
select vessel.dwg.

3 Click Open.

4 On the left half of the status bar, click Ortho Mode to restrict cursor
movements to a horizontal or vertical axis.

5 On the ribbon, click Home tab  ➤  Modeling panel  ➤  Solid Creation
drop-down  ➤  Revolve.

6 Select the arc and press Enter.
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7 At the prompt, enter O for Object and press Enter.

8 Select the line as the object.

9 At the prompt, enter 360 as the angle of revolution and press Enter.

Lesson 3: Revolve 2D Objects Around an Axis | 27



You have created a 3D surface that represents an open surface

10 On the ribbon, click Home tab  ➤  View panel  ➤  Visual Styles drop-down
 ➤  Visual Styles Manger.

11 On the Visual Styles Manager palette, under Available Visual Styles In
Drawing, select Conceptual.

12 Under Face Settings , click the Opacity button.

13 Enter 50.
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The vessel is now transparent.
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14 On the ViewCube located at the upper-right corner of the drawing
window, click Top, Front, Right, and Left to navigate around the vessel.

Summary: In this lesson, you learned how to create 3D solid and surface objects
by revolving 2D closed and open objects around an axis.

Congratulations! You have created 3D objects from 2D objects (profiles)

For more information, see the AutoCAD User’s Guide .
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